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Statement
This manual will help you understand the operation and maintenance of the product better. It
is reminded that the product shall be used strictly complying with this manual. User’s
operation failing to comply with this manual may result in malfunction or accident for which
Edan Instruments, Inc. (hereinafter called EDAN) cannot be held liable.
EDAN owns the copyrights of this manual. Without prior written consent of EDAN, any
materials contained in this manual shall not be photocopied, reproduced or translated into
other languages.
Materials protected by the copyright law, including but not limited to confidential information
such as technical information and patent information are contained in this manual, the user
shall not disclose such information to any irrelevant third party.
The user shall understand that nothing in this manual grants him, expressly or implicitly, any
right or license to use any of the intellectual properties of EDAN.
EDAN holds the rights to modify, update, and ultimately explain this manual.

Responsibility of the Manufacturer
EDAN only considers itself responsible for any effect on safety, reliability and performance
of the equipment if:
Assembly operations, extensions, re-adjustments, modifications or repairs are carried out by
persons authorized by EDAN, and
The electrical installation of the relevant room complies with national standards, and
The instrument is used in accordance with the instructions for use.

Product Information
Product Name: Ultrasonic Pocket Doppler
Model: SD3 LITE, SD3, SD3 PLUS, SD3 PRO, SD3 VASCULAR

I

Terms Used in this Manual
This guide is designed to give key concepts on safety precautions.
WARNING
A WARNING label advises against certain actions or situations that could result in personal
injury or death.
CAUTION
A CAUTION label advises against actions or situations that could damage equipment,
produce inaccurate data, or invalidate a procedure.
NOTE
A NOTE provides useful information regarding a function or a procedure.
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Chapter 1 Safety Guide
CAUTION
Federal (U.S.) Law restricts this device to sale by or on the order of a physician.

NOTE:
This user manual is written to cover the maximum configuration. Therefore, your model
may or may not have some of the parameters and functions described, depending on
what you have ordered.

1.1 Intended Use/Indications for Use
The SD3 Series Ultrasonic Pocket Dopplers are intended to be used by health care professionals
including registered nurses, practical nurses, midwives, ultrasound technicians, and physician
assistants, by prescription from licensed physicians in hospitals, clinics and private offices.
The 2 MHz and 3 MHz waterproof probes are indicated for the detection of fetal heart rate from
early gestation thru delivery and as a general indication of fetal well being. Specifically, the 3
MHz probe is used for more than 9-week gestation and the 2 MHz is used for 12-week gestation.
The 4 MHz, 5 MHz and/or 8 MHz waterproof vascular probes are indicated for the detection of
blood flow in veins and arteries for assisting in the detection of peripheral vascular disease.

1.2 Safety Precautions
Safety of Ultrasound
SD3 was designed with physician and patient safety in mind. In early design phases all potential
hazards were eliminated or reduced to As Low As Reasonably Achievable (ALARA) by adhering
to good design practices and industry wide safety standards. Ultrasound procedures should be
performed with the ALARA principle in mind when delivering ultrasound energy into the body.
The following official statements from the American Institute of Ultrasound Medicine (AIUM)
are provided for your general information regarding the safe use of ultrasound.

Clinical Safety (Approved March 1997, October 1982)
Diagnostic ultrasound has been in use since the late 1950s. Given its known benefits and
recognized efficacy for medical diagnosis, including use during human pregnancy, the American
Institute of Ultrasound in Medicine herein addresses the clinical safety of such use.
There are no confirmed biological effects on patients or instrument operators caused by
exposures from present diagnostic ultrasound instruments. Although the possibility exists that
such biological effects may be identified in the future, current data indicate that the benefits to
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patients of the prudent use of diagnostic ultrasound outweigh the risks, if any that may be present.

Prudent Use (Approved May 1999)
The AIUM advocates the responsible use of diagnostic ultrasound. The AIUM strongly
discourages the non-medical use of ultrasound for psychosocial or entertainment purposes. The
use of either two-dimensional (2D) or three-dimensional (3D) ultrasound to only view the fetus,
obtain a picture of the fetus or determine the fetal gender without a medical indication is
inappropriate and contrary to responsible medical practice. Although there are no confirmed
biological effects on patients caused by exposures from present diagnostic ultrasound instruments,
the possibility exists that such biological effects may be identified in the future. Thus ultrasound
should be used in a prudent manner to provide medical benefit to the patient.

Safety in Training and Research (Approved March 1997, March 1983)
Diagnostic ultrasound has been in use since the late 1950s. There are no confirmed adverse
biological effects on patients resulting from this usage. Although no hazard has been identified
that would preclude the prudent and conservative use of diagnostic ultrasound in education and
research, experience from normal diagnostic practice may or may not be relevant to extended
exposure times and altered exposure conditions. It is therefore considered appropriate to make the
following recommendation:
In those special situations in which examinations are to be carried out for purposes other than
direct medical benefit to the individual being examined, the subject should be informed of the
anticipated exposure conditions, and of how these compare with conditions for normal diagnostic
practice.
This unit is internally powered equipment, and it is an IEC/EN 60601-1 Type B applied
part. Type B protection means that the connection between the equipment and personnel
complies with permitted leakage currents and dielectric strength of IEC/EN 60601-1.
WARNING and CAUTION messages must be observed. To avoid the possibility of injury,
observe the following precautions during the operation of the device.

1

WARNING
The Doppler is a tool to aid the healthcare professional and should not be used in
place of normal fetal monitoring. It is not intended for treatment.

2

Placement of the ultrasound transducer on the abdomen is critical to obtaining the
fetal heart beat as opposed to maternal heart beat or other abdominal noise. The
user should be trained in proper placement techniques either through acceptable
Ob/Gyn training and individual state accreditation, or as being prescribed by such a
trained clinician and trained in device placement.

3

This device is not explosion-proof and can not be used in the presence of flammable
anaesthetics.
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WARNING
Magnetic and electrical fields are capable of interfering with the proper performance
of the device. For this reason, make sure that all external devices operated in the
vicinity of this device comply with the relevant EMC requirements. X-ray equipment
and magnetic resonance imaging (MRI) devices can emit high levels of
electromagnetic radiation.

5

This device is MR unsafe. It is not intended for use in an MRI environment.

6

The device is not protected against defibrillation.

7

Do not use the device with HF surgical equipment.

8

Do not touch the signal input/output connector and the patient simultaneously.

9

Only use the probes provided by the manufacturer.

10 We recommend that exposure to ultrasound should be kept as low as reasonably
achievable. This is considered to be good practice and should be observed at all
time.
11 SHOCK HAZARD - Do not attempt to connect or disconnect a power cord with wet
hands. Make certain that your hands are clean and dry before touching a power
cord.
12 Accessory equipment connected to the analog and digital interfaces must be
certified according to the respective IEC/EN standards (e.g. IEC/EN 60950 for data
processing equipment and IEC/EN 60601-1 for medical equipment). If in doubt,
consult our technical service department or your local distributor.
13 Before using the battery, make sure to read the user manual and safety precautions
thoroughly.
14 Do not heat or throw batteries in fire as this may cause explosion.
15 Do not short-circuit the batteries or install the batteries reversely.
16 Do not attempt to charge normal alkaline batteries. They may leak, catch fire or even
explode.
17 Do not solder the leading wire and the battery terminal directly.
18 Do not destroy the battery: Do not pierce battery with a sharp object such as a
needle; do not hit with a hammer, step on or throw or drop to cause strong shock; do
not disassemble or modify the battery.
19 The battery should be charged, used or stored away from the static electricity.
20 Store the batteries in a cool and dry environment.
21 Do not connect the battery cable connector or battery socket with metal objects,
which can result in short circuit.
22 If rechargeable batteries are used, charge them fully before initial use by using the
method introduced in this manual.
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WARNING
23 The rechargeable batteries should be charged by using the dedicated charger
supplied by the manufacturer.
24 If the rechargeable batteries are stored alone and not used for a long time, we
recommend that the batteries should be charged at least once every 6 months to
prevent overdischarge.
25 Replacement of the battery or charging the battery shall be done at least 1.5 meters
away from patients.
26 The device shall only be used when the battery cover is closed.
27 If the Doppler is not used for a long time, please remove the battery and store it as
required.
28 If the liquid leak from the battery spills onto your skin or clothes, wash well with fresh
water immediately.
29 If the liquid leak from the battery gets into eyes, do not rub the eyes. Wash them well
with clean water and see a doctor immediately.
30 Keep away from fire immediately when leakage or foul odor is detected.
31 Batteries have life cycles. The alkaline batteries are intended to be used once. If the
time that the Doppler using NI-MH battery or lithium battery become much shorter
than usual, the battery life is at an end. Replace alkaline or NI-MH batteries with
those of identical specifications provided by the manufacturer or purchased locally.
Replace lithium batteries with only those provided by the manufacturer.
32 Stop using the battery if abnormal heat, odor, discoloration, deformation or abnormal
condition is detected during use, charge, or storage. Please dispose it according to
the local regulations.
33 Do not immerse, throw, or wet the battery in water/seawater.
34 Do not connect any equipment or accessories that are not approved by the
manufacturer or that are not IEC 60601-1 approved to the device. The operation or
use of non-approved equipment or accessories with the device is not tested or
supported, and device operation and safety are not guaranteed.
35 Using accessories other than those specified by the manufacturer may result in
increased electromagnetic emissions or decreased electromagnetic immunity of the
device.
36 The device should not be used adjacent to or stacked with other equipment and that
if adjacent or stacked use is necessary, the device should be observed to verify
normal operation in the configuration in which it will be used.
37 The medical electrical equipment needs to be installed and put into service
according to the EMC Information provided in this user manual.
38 Portable and mobile RF communications equipment can affect medical electrical
equipment, refer to section A3.4 Recommended Separation Distances.
39 Do not service or maintain the device or any accessory which is in use with a patient.
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WARNING
40 The appliance coupler or mains plug is used as isolation means from supply mains.
Position the Doppler in a location where the operator can easily access the
disconnection device.

1

CAUTION
Refer servicing to qualified personnel.

2

The main unit is designed for continuous operation and is ‘ordinary’. Do not immerse
it in any liquid (i.e. not drip or splash-proof).

3

Keep the device in a clean environment and avoid vibration during storage.

4

Do not sterilize the Doppler with autoclave or gas.

5

Electromagnetic Interference - Ensure that the environment in which the device is
operated is not subject to any source of strong electromagnetic emissions, such as
radio transmitters, mobile telephones, etc.

6

Prior to examination using the Doppler, check for visible damages of the main unit
and the probe that may endanger the patient/operator or machine performance. If
the damage is found, replace them with good ones at once.

7

The following safety checks should be performed once every two years or as
specified in the institution’s test and inspection protocol by a qualified person who
has adequate training, knowledge, and practical experience to perform these tests.


Inspect the equipment for mechanical and functional damage.



Inspect the safety relevant labels for legibility.



Verify that the device functions properly as described in the instructions for use.



Test the pregnant woman’s leakage current according to IEC 60601 Limit:
10 µA, a.c 100 µA.

d.c

The leakage current should never exceed the limit. The data should be recorded in
an equipment log. If the device is not functioning properly or fails any of the above
tests, the device has to be repaired.
8

The device and accessories are to be disposed of according to local regulations after
their useful lives. Alternatively, they can be returned to the dealer or the
manufacturer for recycling or proper disposal. Batteries are hazardous waste. Do
NOT dispose them together with house-hold garbage.
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1.3 Symbols
No.

Symbol

Definition

1

CE marking

2

Disposal method

3

Caution: Federal (U.S.) law restricts this device to sale by
or on the order of a physician.

4

Operating instructions

5

Caution

6

MR Unsafe – keep away from magnetic resonance imaging
(MRI) equipment

7

Current: Direct

8

TYPE B APPLIED PART

9

Part Number

10

SERIAL NUMBER

11

Date of manufacture

12

MANUFACTURER

13

AUTHORISED REPRESENTATIVE IN THE
EUROPEAN COMMUNITY

14

General symbol for recovery/recyclable

15

Power adapter connector
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Headphones

17

Output

18 *

Safety Guide

Conforms to UL Std. 60601-1, IEC Std. 60601-2-37
Certified to CSA Std. C22.2 No 601.1, CSA Std. C22.2 No
60601-2-37,

Refer to User Manual
19
(Background: Blue; Symbol: White)
Warning
20
(Background: Yellow; Symbol&Outline: Black)
NOTE:
1)

* The symbol for UL is only for UL model.

2)

The user manual is printed in black and white.
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Chapter 2 Doppler and Accessories
2.1 Features
There are five different models available: SD3 LITE, SD3, SD3 PLUS, SD3 PRO and SD3
VASCULAR.
SD3 LITE and SD3 VASCULAR are for simple auscultation (intermittent listening). SD3, SD3
PLUS and SD3 PRO not only detect fetal heart sound; they also display the fetal heart rate on an
OLED screen.
The features of the Dopplers are listed in the following chart.
Model

SD3 LITE

SD3

SD3 PLUS

SD3 PRO

SD3 VASCULAR

Display Panel

×

√

√

√

×

LED Indicator

√

×

×

×

√

No Signal Auto
Shutdown

×

√

√

√

×

HR Display

×

√

√

√

×

Power Display

×

√

√

√

×

Low Power Hint

√

√

√

√

√

Noise Reduction

×

×

√

√

×

Audio Play

√

√

√

√

√

Volume Adjustable

√

√

√

√

√

Earphone Socket

√

√

√

×

√

Record/PC Upload

×

×

×

√

×

Probe Auto Shutdown

×

×

√

√

×

Probe Changeable

√

√

√

√

√

8 MHz Waterproof
Probe

Optional

Optional

Optional

Optional

Optional

5 MHz Waterproof
Probe

Optional

Optional

Optional

Optional

Optional

4 MHz Waterproof
Probe

Optional

Optional

Optional

Optional

√

Function
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3 MHz Waterproof
Probe

√

√

√

√

×

2 MHz Waterproof
Probe

Optional

Optional

Optional

Optional

×

Portable bag

√

√

√

√

√

Power Adapter

×

×

√

√

×

Optional

Optional

×

×

Optional

Optional

Optional

×

×

Optional

Charge Stand

×

×

Optional

Optional

×

Charging the Doppler

×

×

√

√

×

Rechargeable Lithium
Battery

×

×

√

√

×

Trolley

Optional

Optional

Optional

Optional

Optional

Gel

√

√

√

√

√

AA size Alkaline
Battery
Rechargeable NI-MH
Battery/Charger

√ = configured

× = not available

For the Essential Performance of SD3 series, refer to Appendix 1 in details.

2.2 Main Unit
NOTE:
The pictures and interfaces in this manual are for reference only.

2.2.1 Appearance
Take 2 MHz obstetrical probe for example.

3
1

2

SD3 PRO/SD3 PLUS/SD3

SD3 LITE

Figure 2-1 Front Panel
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6
4

SD3 PRO/SD3 PLUS

5

SD3/SD3 LITE/ SD3 VASCULAR

Figure 2-2 Rear Panel

8

Figure 2-3 Left Panel

10
11
12
13

9

Figure 2-4 Top Panel
1

4

Display Panel (SD3
PRO/SD3/SD3 PLUS)
Battery Compartment
(SD3 PLUS/SD3 PRO)

Figure 2-5 Right Panel
Speaker

3

5

Charge Stand Socket
(SD3 PLUS/SD3 PRO)

6

Battery Compartment (SD3
LITE/SD3/ SD3 VASCULAR)

9

Probe

12

Charge Socket (SD3 PLUS/SD3
PRO)

Volume Control

8

Probe Holder

10

Probe Socket

11

Audio Socket
PRO)

14

Earphone Socket (SD3
LITE/SD3/SD3 PLUS/
SD3 VASCULAR)

Record Button
(SD3 PRO)

Working State Indicator

2

7

13

14

(SD3

(SD3 LITE/SD3 VASCULAR)

2.2.2 Display Panel
For SD3, SD3 PRO, and SD3 PLUS, the OLED is shown as follows:
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Play

Real-time Test

Figure 2-6 OLED Display

When 4/5/8 MHz vascular probe is plugged in, the OLED displays the probe type instead of the
FHR.
No.
1

Symbol

Description
HR being calculated
Full capacity
3/4 capacity

2

2/4 capacity
1/4 capacity
Empty, the flickering interface prompts replacement or
charging of battery.

3

HR: 50-240

4

SD3 PRO: in playing status

5

SD3 PRO: in recording status

6

The machine is not connected to the probe.

7

Probe frequency
Charge interface:

8

Electric energy pane refreshed from negative polarity
to positive polarity
charge completed
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charge error

For SD3 LITE without OLED, the LED is shown as follows:
Power on

Green

Power off

Off

Low capacity

Orange

Probe off

Flickering green

Probe off and low capacity

Flickering orange

2.2.3 Buttons
There is a push button (REC/PLAY), a volume control button and a power button on the main
unit of the Doppler. Their primary functions are as follows:
(1) REC/PLAY
(Only for SD3 PRO)

Function: Start/ stop recording or playing fetal heart sound.

(2) Volume Control Indicator
Function: Adjust volume. Rotate the volume gear toward “+” to turn up the volume, while
rotate it toward “-” to turn down the volume.
(3) Power
Function: Power the Doppler on or off.

2.2.4 Socket
The two sockets are located on the side panel of the Doppler.

(1) Earphone socket
: (SD3 LITE, SD3, SD3 PLUS, SD3 VASCULAR) for outputting
audio signals, the earphone or line-in cable connects to the Doppler via this socket.

Audio output

:

(SD3 PRO) for outputting audio signals.
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(2) Charge socket
: (SD3 PRO, SD3 PLUS) for charging the battery, the dedicated
power adapter connects to the Doppler via this socket.
NOTE:
Accessory equipment connected to the analog and digital interfaces must be certified
according to the respective IEC/EN standards (e.g. IEC/EN 60950 for data processing
equipment and IEC/EN 60601-1 for medical equipment). If in doubt, consult our
technical service department or your local distributor.

2.2.5 Probe Socket
The probe socket is as shown in figure 2-7.

Figure 2-7 Probe socket

Connect the probes supplied by the manufacturer to the Doppler through the probe socket.
CAUTION
1 Do not try to connect any other plug to the probe socket except the plug of the probes
mentioned above.
2 Do not stretch the probe cable for more than two meters long.

2.2.6 Batteries
SD3 LITE, SD3 and SD3 VASCULAR are powered either by three alkaline batteries or three
rechargeable NI-MH batteries.
SD3 PLUS and SD3 PRO are powered by a lithium battery.
NOTE:
The alkaline battery and rechargeable NI-MH battery can be replaced by those of
identical specifications purchased locally.
Alkaline battery: AA, LR6, 1.5 V.
Rechargeable NI-MH battery: AA, R6, 1.2 V.
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2.3 Probes
2.3.1 Waterproof Obstetrical Probes
2 MHz/3 MHz waterproof obstetrical probes can be connected to the main unit for fetal heart
examining.
The 2 MHz obstetrical probe features in deep penetration and is designed for use during the third
trimester pregnancy. The 3 MHz obstetrical probe features in high sensitivity and is designed for
use as early as 9 weeks.

Figure 2-8 2/3 MHz obstetrical probe

2.3.2 Waterproof Vascular Probes
The 4 MHz/5 MHz/8 MHz waterproof vascular probes can be connected to the main unit for
artery and vein blood flow examining.

Figure 2-9 4/5/8 MHz Vascular Probes
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Chapter 3 Basic Operation
NOTE:
To ensure that the Doppler works properly, please read this chapter and Chapter 1
Safety Guide before operation; follow the steps when connecting all the components.

3.1 Opening the Package and Checking
Open the package; take out the Doppler and accessories carefully. Keep the package for possible
future transportation or storage. Check the components according to the packing list.
 Check for any mechanical damage.
 Check all the cables and accessories.
If there is any problem, contact us or your local distributor immediately.

3.2 Installing/Replacing Battery


SD3 LITE, SD3, SD3 VASCULAR

Battery Installation
WARNING
1

Replace alkaline or NI-MH batteries with those of identical specifications provided by
the manufacturer or purchased locally. Replace lithium batteries with only those
provided by the manufacturer. See Appendix 1 Product Specifications for details
about battery specifications.

2

If the batteries have been inserted incorrectly, the Doppler will not function or it will
be damaged.

Open the battery compartment by depressing the tab and pulling outward the battery door. Insert
the battery such that the spring contacts are loaded and then press the battery firmly into place.
The direction of the batteries should comply with the polar mark on the cover. Reversed
connection is forbidden. After all three have been inserted, replace the battery door.
Battery Removal
Take out the battery in reverse order. Open the battery compartment by depressing the tab and
pulling outward the battery door. Remove the existing drained batteries by pushing on the end of
the battery that compresses the battery contact spring and lifting upwards. It is acceptable to
carefully use a simple tool, such as a pen, to assist in lifting the batteries out.

- 15 -

SD3 Series Ultrasonic Pocket Doppler User Manual



Basic Operation

SD3 PLUS, SD3 PRO

Battery Installation
1) Remove the screws of the battery compartment using a cross-head screw driver. Remove
the battery compartment cover.
2) Put the battery in the compartment.
3) Shut the battery compartment cover and fix it with the screws.
Battery Removal
Remove the battery in reverse order.
NOTE:
1

If a rechargeable battery is outfitted, charge it fully each time after using the device
to ensure the electric power is enough.

2

When the battery configuration is provided, after the device is transported or stored,
the battery must be charged. Connecting to power supply will charge the battery no
matter if the Doppler is powered on.

3

The installation of battery must be carried out by qualified personnel authorized by
EDAN.

3.3 Probe Operation
(1) Taking out the probe
Hold the main unit with one hand. Pinch the probe and pull it outwards using mild force.
(2) Placing the probe
Hold the main unit with one hand. Pinch the probe and align it with the probe holder. Push the
probe inwards using mild force until it clicks in position.
(3) Replacing the Probe
Remove the old probe:
Switch off the Doppler; hold the main unit with one hand and pinch the jacket of the mini USB
socket. Lift the jacket up slightly and pull it out with mild force; take out the probe.
CAUTION
Do not pull the probe cable directly.
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Replace it with a new probe:
Put the USB socket of new probe into the probe interface of the Doppler.
NOTE:
Place the temporarily unused probe carefully and avoid falling off, splash or stress, etc.
When the Doppler is not used for a long time, it’s recommended to connect the probe to
the Doppler and keep them safely in the package.

3.4 Switching On
Press the POWER button on the front panel to switch on the Doppler, the OLED displays
.

If the probe is not connected or poorly connected, the OLED displays
reconnect the probe properly.

. You should

When the probe is well connected, the OLED shows the probe frequency
.

3.5 Switching Off
Press the POWER button on the front panel to switch off the Doppler.
For SD3, SD3 PRO and SD3 PLUS, it switches off automatically if there is no input signal or no
operation is performed for 60 seconds.
For SD3 PRO and SD3 PLUS, it switches off automatically if the probe is replaced in the probe
holder.

3.6 Replacing/Charging the Battery
3.6.1 Battery Energy Indication
After switched on, the Doppler gives indication of battery energy.
For SD3 PRO, SD3 and SD3 PLUS, there is a battery symbol in the up right corner of OLED.
The panes in it indicate the battery electric energy.

The panes disappear gradually with the energy consumption. When the energy is low, the empty
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battery symbol flashes. Approximately five minutes later, the Doppler shuts down automatically.
You should replace the batteries or charge the rechargeable batteries.

3.6.2 Replacing Alkaline Batteries
CAUTION
Make sure the Doppler is shut down before charging the battery or opening the battery
compartment.
When the alkaline batteries are low in energy, they should be removed from the main unit, by
using the procedures described in section 3.2 Installing/Replacing Battery. Dispose of them
according to local regulations.
New alkaline batteries with identical specifications are required. Install them to the Doppler as
introduced in section 3.2.
WARNING
DO NOT CHARGE THE ALKALINE BATTERY.

3.6.3 Charging the NI-MH Batteries
When the rechargeable NI-MH batteries are low in energy,
1) Take the NI-MH batteries out from the main unit by using the procedures described in
section 3.2 Installing/Replacing Battery.
2) Replace them with new batteries of identical specifications, or charge them with the
provided charger.
To charge the rechargeable NI-MH batteries,
1) Fit the NI-MH batteries in the charger slots properly. Make sure the direction of the
batteries complies with the polar marks in the slots.
2) Plug the charger into an AC power supply socket. During charging, the indicators of the
corresponding charger slots light up in red.
3) When the charging indicators turn green, the batteries are fully charged (about 5 hours
are needed). Take the batteries out from the charger and reinstall them to the Doppler.
The specifications of the provided charger are as follows:
Input: AC 100-240 V, 50/60 Hz
Output: 1-2 AA@1000 mA, 3-4 AA@500 mA
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NOTE:
If the charging indicators are flashing in red, it indicates that the batteries are defective
or non-rechargeable or that short circuit occurs.
WARNING
Make sure the batteries are not connected reversely before plugging the charger into the
power socket.

3.6.4 Charging the Doppler (SD3 PLUS, SD3 PRO)
Put the plug of the power adapter into the charge socket of the Doppler, and connect the power
adapter to a power supply socket.
During charging, a battery sign appears on the OLED with continuously changing energy sign.
When the charging indicator shows full status, the battery finishes charging. Remove the power
adapter plug and the Doppler is ready for examining again.
The specifications of the provided power adapter are as follows:
Input: AC 100-240 V, 50/60 Hz, 0.2 A
Output: DC 5 V, 1 A

3.6.5 Charging the Charge Stand
For the Doppler equipped with a charge stand, put the plug of the power adapter into the charge
socket of the charge stand, and then connect the power adapter to a power supply socket.
The specifications of the provided charge stand are as follows:
Input: DC 5 V, 1 A
Output: DC 5 V, 1 A
The specifications of the provided power adapter are as follows:
Input: AC 100-240 V, 50/60 Hz, 0.2 A
Output: DC 5 V, 1 A
The charge stand can be put on a table or fixed on the wall as below.
On a table: Put the charge stand on a flat table.
On the wall: Aim the two bracket holes in the back of the charge stand to the wall, leave two
marks and drill in the marked place. Screw in each hole and make sure the screws are fixed in the
wall. Aim the bracket holes to the screws on the wall and fix the screws in the hole and tighten
the screws.
The Doppler can be charged when placed in the charge stand.
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Figure 3-1 On a Table

Basic Operation

Figure 3-2 On the Wall

NOTE:
The Doppler is not available for examining during charging.
WARNING
1

The charge stand can be fixed only on a concrete wall.

2

When you need to install the charge stand a second time, drill new holes and
change the screws.

3

The charger and the power adapter meet the requirements of Standard IEC60950,
and they should be placed outside the patient environment when they are working
(1.5 m away from the patient).
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Chapter 4 Examining
4.1 FH Examining
Before applying the Doppler for fetal heart (FH) examining, a proper probe should be chosen.
The 3 MHz waterproof probe is used for more than 9-week gestation and the 2 MHz is used for
more than 12-week gestation.
NOTE:
In some cases, fetal heart beats at 9 weeks gestation cannot be detected due to the
maternal physical difference and the operator’s technique.
Perform fetal heart examining using the following procedures:
1) Confirm the fetus’s position by hand.
2) Determine the probable probe location for optimal FHR examining.
3) Take out the probe and switch on the Doppler.
4) Apply a certain amount of coupling gel to the probe faceplate and place the probe against the
abdomen at the predetermined location. Move the probe around or tilt it until clear and
rhythmic heart sound is heard from the headphone or speaker. At the same time, a numeric
FHR is displayed on the OLED (except SD3 LITE and SD3 VASCULAR).

NOTE:
1

The best quality records will only be obtained if the probe is placed in the optimum
position.

2

Positions with strong placental sounds or umbilical blood flow sound should be
avoided.

3

If the fetus is in the cephalic position and the mother is supine, the clearest heart
sound will normally be found on the midline below the umbilicus. During examining,
the pregnant woman’s prolonged lying in the supine position should be avoided
owing to the possibility of supine hypotension. Sitting up or lateral positions are
preferable and may be more comfortable.

4

It is impossible to examine FHR unless a fetal heart sound is present. The fetal pulse
can be distinguished from the maternal pulse by feeling the mother’s pulse during
the examination.
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When applied to the patient, the ultrasound transducer may warm slightly (less than
5°C (9°F) above ambient temperature). When NOT applied, the ultrasound
transducer may warm slightly (less than 4°C (7.2°F) above ambient temperature).

4.2 FH Sound Recording and Playing
This function is only available with SD3 PRO.
Recording:
Press and hold the
OLED reads

button for three seconds, the machine starts recording, and the
.

The longest record time is 240 seconds. When the time is up or the
again, the Doppler stops recording and returns to the real-time status.

button is pressed

NOTE:
Only the last set of recorded fetal heart sounds is saved in the Doppler. It is cleared
when new sounds are recorded.
Playing:
Press the

button once, the machine plays the recorded sound, and the OLED reads
.

When the recorded sound comes to the end or the
stops playing and returns to the real-time status.

button is pressed again, the Doppler

NOTE:
Observe the OLED, pay attention not to mistake the recorded fetal heart sound for the
real-time sound.

4.3 FH Sound Recording by PC
4.3.1 Recording Sounds
1. Insert one plug of the special line-in cable supplied by the manufacturer to the audio input
socket (the socket with the symbol “

”) of the PC. If the PC has no audio input socket,

insert the plug into the microphone socket (the socket with the symbol “
- 22 -
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2. Turn on PC and run the sound recorder (Click on Start > Programs > Accessories >
Entertainment > Sound Recorder). Perform FHR examination with the method described
in section 4.1. When the ideal signal is detected, unplug the earphone (if it’s connected) and
insert the other plug of the audio cable into the earphone socket on the Doppler.
3. Click on the start key to start recording. You can record 60 seconds each time. When the time
is up, click on the start key again to keep on recording.
4. Click on the stop key to stop recording.
5. Click on File > Save, input the file name, select a folder and click on Save to save the signals
in a “.wav” file.
To start new recording, click on File > New.

4.3.2 Playing Sound Files
The recorded sounds are saved as waveform (.wav) files in your computer.
You can play the waveform file with the sound recorder. Run the sound recorder, click on File >
Open, search for the folder and select the file, click on Open to load the file, and then click on
the play key.
If you have any other program that supports waveform (.wav) files installed on your PC,
double-click on the file to play it.

4.3.3 Burning CD or Sending in Email
The waveform files saved in your PC are normal audio data files. You can burn them into CDs or
e-mail to whomever you want.

4.3.4 Record Troubleshooting
If there is audio output from the speaker or earphone, but the PC recorder does not have any input.
(The green line recording area has no waveform.) The reason could be:
1. Poor connection of the audio cable between the Doppler and the PC.
- Check the plugs of the cable and re-connect it if any poor connection is detected.
2. The audio cable has been plugged to the wrong socket of the PC, instead of the audio input
socket or the microphone socket.
- Insert the plug to the right socket.
3. The Line in or microphone is muted on PC.
- Change the setting of the PC in these steps:
1) Double-click on the volume symbol in the bottom right corner of your desktop.
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2) If the line in or/and microphone volume control is/are not shown in the Volume Control
menu, click on Options > Properties, tick Line In and Microphone and click on OK.
3) Make sure Line In and Microphone is not mute and exit.
4) Start new recording.

4.4 Vascular Examining (Optional)
WARNING
The Doppler is not intended for ophthalmic use. Do not use it for examining ophthalmic
vessels, or any other procedures which may cause the ultrasound beam to pass through
the eye.
4 MHz, 5 MHz or 8 MHz vascular probes are to be connected to the Doppler to perform vascular
examination.
Choose the appropriate probe as required. The probe with low frequency has a deeper penetration
depth, while the probe with high frequency has better resolution and wider detecting range. The 4
MHz vascular probe is optimized for examining blood vessels; the 5 MHz vascular probe is
optimized for examining deeper vessels, and the 8 MHz vascular probe is optimized for
examining surface vessels.
Apply a liberal amount of gel on the site to be examined. Place the probe at a 45ºangle on the skin
over the vessel to be examined. Adjust the position of the probe to obtain the loudest blood flow
sound. Refer to figure 4-1 for the probe sites:
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Vertebral
VertebralArtery
Artery(4/5
(4.0MHz)
MHz)
Carotid
CarotidArtery
Artery(4.0/8.0MHz)
(4/5/8 MHz)

Carotid
Artery
(4/5/8 MHz)
Carotid
Artery
(4.0/8.0MHz)

Jugular
JugularVein
Vein(4/5
(4.0MHz)
MHz)

Subclavian
SubclavianArtery
Artery(4/5
(4.0MHz)
MHz)
Subclavian Vein (4/5
(4.0MHz)
MHz)

Brachial
BrachialArtery
Artery (8.0MHz)
(8 MHz)
Ulnar
Ulner Artery (8.0MHz)
(8 MHz)
Radial Artery (8
(8.0MHz)
MHz)

Femoral Artery
Femoral Artery(4/5
(4.0MHz)
MHz)

Femoral Vein
Hz)
(4/5 MHz)

Popliteal
PoplitealArtery
Artery(4/5
(4.0MHz)
MHz)

Great Saphenous Vein
Great Saphenous Vein (4.0/8.0MHz)
(4/5/8 MHz)
Small Saphenous
Vein
Small Saphenous
Vein (8.0MHz)
(8 MHz)

Posterior
PosteriorTibial
TibialArtery
Artery(8.0MHz)
(8 MHz)

Dorsalis Pedis Artery
(8 MHz)
Posterior Tibial Vein
(8.0MHz)
(8 MHz)

Figure 4-1 Probe sites

For best results, keep the probe as still as possible once the optimum position is found. Adjust the
volume as required. High pitched pulsatile sounds are emitted from arteries while veins emit a
non-pulsatile sound similar to a rushing wind.
Vascular examination only provides audio signals of arteries and veins. The OLED screen always
displays the probe frequency.
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NOTE:
When applied to the patient, the ultrasound transducer may warm slightly (less than 6°C
(10.8°F) above ambient temperature). When NOT applied, the ultrasound transducer
may warm slightly (less than 6°C (10.8°F) above ambient temperature).

4.5 Completing Examining
After examining,
1) Switch off the Doppler.
2) Wipe the remaining gel off the patient and the probe with a clean soft cloth or tissue.
3) Place the probe back to the holder.
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Chapter 5 Maintenance
5.1 Maintenance
You must check that the equipment does not have visible evidence of damage that may affect the
patient and the operator’s safety or the Doppler’s capability before each use. Pay special attention
to the cracks on the probe and the cable before immersing them into conductive fluid. If the
damage is evident, replacement is recommended.
The probe is frangible and must be handled with care.
Wipe the remaining gel after use to prolong the probe life.
The overall check of the Doppler, including safety check and function check, should be
performed by qualified personnel every 12 months, and each time after service. Besides the above
requirements, comply with local regulations on maintenance and measurement.

5.2 Cleaning
Before cleaning, switch off the Doppler.
Keep the exterior surface of the device clean and free of dust and dirt.
Clean the exterior surface of the main unit with a dry, soft cloth. If necessary, clean it using a soft
cloth dampened with mild near neutral detergent, ethanol (75%) or isopropanol (70%), and then
wipe it dry with a dry cloth immediately.
Wipe the remaining coupling gel off the probe. Clean it using a soft cloth dampened with mild
near neutral detergent, ethanol (75%) or isopropanol (70%), and then air-dry it or wipe it dry with
a dry cloth.
CAUTION
1

Do not use strong solvent, such as acetone.

2

Never use an abrasive such as steel wool or metal polish.

3

The main unit is not waterproof. Do not immerse any part of it into liquid.

4

Avoid pouring liquids on the main unit while cleaning.

5

Do not remain any solution on the surface after cleaning.

6

Only the body and cable of the probe are waterproof. Do not immerse the probe
socket into any liquid.

5.3 Disinfection
In normal use the main unit does not need disinfection. In case of being soiled, clean the main
unit case and then disinfect it by wiping it with a soft cloth dampened with ethanol (75%) or
isopropanol (70%). Then wipe it dry with a dry cloth.
After each use, clean the probe and then disinfect it by wiping it with a soft cloth dampened with
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ethanol (75%) or isopropanol (70%). Then wipe it dry with a dry cloth.
CAUTION
Pay attention not to immerse the probe socket into the disinfector.

5.4 Sterilization
Do not sterilize the Doppler, unless this is necessary according to your hospital regulation.
NOTE:
After cleaning or disinfection, check if the Doppler functions well. If any problem is
detected, please contact the manufacturer for service before reusing it.
Checking Item

Checking Method

Visual Check

Inspect the Doppler for any damage.

Function Check

Check if the Doppler can be switched on or off properly (see 3.4 Switching On
and 3.5 Switching Off). When the Doppler is switched on, check if the display
panel works as described in 2.2.2 Display Panel; touch the probe faceplate
gently with your hand and check if the Doppler gives out sound normally.
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Chapter 6 Warranty and Service
6.1 Warranty
EDAN warrants that EDAN’s products meet the labeled specifications of the products and will be
free from defects in materials and workmanship that occur within warranty period.
The warranty is void in cases of:
a) damage caused by mishandling during shipping.
b) subsequent damage caused by improper use or maintenance.
c) damage caused by alteration or repair by anyone not authorized by EDAN.
d) damage caused by accidents.
e) replacement or removal of serial number label and manufacture label.
If a product covered by this warranty is determined to be defective because of defective materials,
components, or workmanship, and the warranty claim is made within the warranty period, EDAN
will, at its discretion, repair or replace the defective part(s) free of charge. EDAN will not provide
a substitute product for use when the defective product is being repaired.

6.2 Contact information
If you have any question about maintenance, technical specifications or malfunctions of devices,
contact your local distributor.
Alternatively, you can send an email to EDAN service department at: support@edan.com.cn.
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Appendix 1 Product Specifications
Product Name: Ultrasonic Pocket Doppler
Model:
SD3 LITE, SD3, SD3 PLUS, SD3 PRO, SD3 VASCULAR
Safety:
Complies with:

IEC 60601-1:2005, EN 60601-1:2006, IEC 60601-1-2:2014,
EN 60601-1-2:2015, IEC/EN 61266:1994, EN 60601-2-37: 2008,
IEC 60601-2-37:2007

Classification:
Anti-electric Shock Type:

Internally powered equipment

Anti-electric Shock Degree:

Type B equipment

Degree of Protection against Harmful Ingress of Water:

Probes:

Ordinary equipment (Sealed equipment without
liquid proof)
IPX8 Water Ingress Protection Code

Degree of Safety in Presence
of Flammable Gases:

Equipment not suitable for use in presence of
flammable gases

Working System:

Continuous running equipment

EMC:

CISPR 11 Group 1 Class B

Main Unit:

Physical Characteristic:
Main Unit
Size: 168 mm x 31 mm x 67 mm
Weight: about 350 g (including the battery)
Probe
Weight: <100 g
Cable Length: 2 m
Size (obstetrical probe): 39 mm x 140 mm
Size (vascular probe): 25 mm x 115 mm
Charge Stand
Size: 96 mm x 93 mm x 100 mm
Weight: <200 g
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Environment:
Working:
Temperature:

+5°C ~ +40°C ( +41ºF ~ +104ºF)

Humidity:

25% RH ~ 80% RH(non-condensing)

Atmospheric Pressure:

86 kPa ~ 106 kPa

Transport and Storage:
Temperature:

-20°C ~ +55°C (-4ºF ~ +131ºF)

Humidity:

25% RH ~ 93% RH (non-condensing)

Atmospheric Pressure:

70 kPa ~106 kPa

Display:
0.96’’ OLED double color screen
FHR Performance (Essential Performance):
FHR Measuring Range:
Resolution:
Accuracy:

50 bpm ~ 240 bpm
1 bpm
±2 bpm

Sensitivity: 9 weeks gestation (3 MHz)
Audio Output Power: 2 W
Recording and Playing:
Audio Sampling Frequency: 4 kHz
Recording Length: 240 seconds
Auto Shut down:
1 minute after no signal or operation, auto shut down
Probe replacement, auto shut down
Recommended Battery Type:
Alkaline battery (AA LR6 1.5 V)
Rechargeable NI-MH battery (AA R6 1.2 V)
Ultrasonic Gel:
pH: 5.5~8.0
Acoustic Impedance: 1.5x106~1.7x106 Pa . s/m (in 35°C(95ºF))
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Battery Supply
Type
Internal
battery

Battery
 Support 3 AA alkaline battery LR6
Normal working time: ≥10 hours (recommended battery)
(Please use the new battery in 22°C~26°C (71.6ºF~78.8ºF), when you
plug the probe to start simulated monitoring.)
 Support 3 AA rechargeable NI-MH battery R6
1) Normal working time: ≥10 hours
(Please use the newly charged battery in 22°C~26°C (71.6ºF~78.8ºF),
when you plug the probe to start simulated monitoring.)
2) Charge mode: rechargeable NI-MH battery charger
3) Charge time: about 5 hours
 Support charging rechargeable lithium battery in the Doppler
1) Normal working time: ≥16 hours (recommended battery)
(Please use the newly charged battery in 22°C~26°C (71.6ºF~78.8ºF),
when you plug the probe to start simulated monitoring.)
2) Charge mode: charge in the Doppler
3) Charge time: ≤6 hours

Rechargeable Lithium Battery
Nominal Capacity:

2600 mAh

Nominal Voltage:

3.7 V

Work Temperature

Storage Temperature:

Charging Temperature: 0°C  +45°C (+32ºF ~ +113ºF)
Discharging Temperature: -20°C  +60°C (-4ºF ~
+140ºF)
Within 1 Month
0°C  +45°C (+32ºF ~ +113ºF)
1-3 Month
0°C  +35°C (+32ºF ~ +95ºF)
3-12 Month
0°C  +25°C (+32ºF ~ +77ºF)

Ultrasound

Nominal Frequency

Working Frequency

2.0 MHz Obstetrical Probe

2.0 MHz

3.0 MHz Obstetrical Probe

3.0 MHz

4.0 MHz Vascular Probe

4.0 MHz

5.0 MHz Vascular Probe

5.0 MHz

8.0 MHz Vascular Probe

8.0 MHz

2.0 MHz Obstetrical Probe

(2.0±10%) MHz

3.0 MHz Obstetrical Probe

(3.0±10%) MHz

4.0 MHz Vascular Probe

(4.0±10%) MHz
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5.0 MHz Vascular Probe

(5.0±10%) MHz

8.0 MHz Vascular Probe

(8.0±10%) MHz

2.0 MHz/3.0 MHz
Obstetrical Probe
4.0 MHz/5.0 MHz/8.0
MHz Vascular Probe

p- < 1 MPa Iob < 20 mW/cm2

Ispta < 100 mW/cm2

p- < 1 MPa Iob < 25 mW/cm2

Ispta < 100 mW/cm2

Working Mode

Continuous wave Doppler

Effective Radiating
Area of Transducer

2.0 MHz Obstetrical Probe

(245±15%) mm2

3.0 MHz Obstetrical Probe

(245±15%) mm2

4.0 MHz Vascular Probe

(32±15%) mm2

5.0 MHz Vascular Probe

(32±15%) mm2

8.0 MHz Vascular Probe

(14±15%) mm2

Low Output Summary Table
(for systems with no transducers having global maximum index values exceeding 1.0)
System: SD3 Series Ultrasonic Pocket Doppler
Transducer Model
(MHz)

Ispta.3
(mW/cm2)

CW 2.0

26.4861

CW 3.0

25.061

CW 4.0

16.845

CW 5.0

29.5496

CW 8.0

9.4761

TI Type

TI Value

TIS

0.1589

TIB

0.4030

TIS

0.2891

TIB

0.4628

TIS

0.1275

TIB

0.1461

TIS

0.1821

TIB

0.2364

TIS

0.0981

TIB

0.0555
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Isppa.3
(W/cm2)

0.01936

0.02649

0.01776

0.02506

0.01185

0.01685

0.01281

0.02955

0.005621

0.009476
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Appendix 2 Ordering Information
CAUTION
Only the parts supplied by the manufacturer should be used with the Doppler.

Parts

Part Number

Probe
2.0 MHz Obstetrical Probe

12.01.210721

3.0 MHz Obstetrical Probe

12.01.210722

4.0 MHz Vascular Probe

12.01.210875

5.0 MHz Vascular Probe

12.01.210876

8.0 MHz Vascular Probe

12.01.210877

Accessory
Alkaline Batteries

01.21.064086

Rechargeable NI-MH Batteries

21.21.064180

NI-MH Battery Charger

01.21.064218

Lithium Battery

21.21.064198

Power Adapter (American Standard)

21.21.064158

Power Adapter (European Standard)

01.21.064161

Power Adapter (Brazilian Standard)

21.21.064184

Charge Stand

02.06.260996

Normal Carry Case

01.56.465616
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Appendix 3 EMC Information
A3.1 Electromagnetic Emissions
Guidance and manufacture’s declaration–electromagnetic emission
The SD3 Series Ultrasonic Pocket Doppler is intended for use in the electromagnetic environment
specified below. The customer or the user of the device should assure that it is used in such an
environment.

Emission test

Compliance

Electromagnetic environment–guidance

RF emissions
CISPR 11

Group 1

The SD3 Series Ultrasonic Pocket Doppler uses RF energy only
for its internal function. Therefore, its RF emissions are very low
and are not likely to cause any interference in nearby electronic
equipment.

RF emission
CISPR 11

Class B

Harmonic
emissions
IEC/EN61000-3-2

Not applicable

Voltage
fluctuations
/flicker emissions
IEC/EN61000-3-3

Not applicable

The SD3 Series Ultrasonic Pocket Doppler is suitable for use in
all establishments, including domestic establishments and those
directly connected to the public low-voltage power supply
network that supplies buildings used for domestic purposes.
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A3.2 Electromagnetic Immunity
Guidance and manufacture’s declaration–electromagnetic immunity
The SD3 Series Ultrasonic Pocket Doppler is intended for use in the electromagnetic environment
specified below. The customer or the user of the device should assure that it is used in such an
environment.

Immunity test

IEC 60601 test level

Compliance
level

Electromagnetic
environment-guidance

Electrostatic
discharge (ESD)
IEC 61000-4-2

8 kV contact
15 kV air

8 kV contact
15 kV air

Floors should be wood,
concrete or ceramic tile. If
floor are covered with
synthetic material, the relative
humidity should be at least
30%.

Electrical Fast
Transient/Burst
IEC/EN61000-4-4

±2 kV for power supply lines
±1 kV for input/output lines

Not applicable

Not applicable

Surge
IEC/EN61000-4-5

±1 kV line(s) to line(s)
±2 kV line(s) to earth

Not applicable

Not applicable

<5%UT(>95% dip inUT)
for 0.5cycle
40%UT(60%dip in UT)
for 5 cycles
70%UT(30%dip in UT)
for 25 cycles
<5%UT(>95% dip in UT)
for 5s

Not applicable

Not applicable

Voltage dips, short
interruptions, and
voltage variations
on power supply
input lines
IEC/EN61000-4-11

Power frequency
(50 Hz/60 Hz)
magnetic field
IEC61000-4-8

30 A/m

30 A/m
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A3.3 Electromagnetic Immunity
Guidance and manufacture’s declaration – electromagnetic immunity
The SD3 Series Ultrasonic Pocket Doppler is intended for use in the electromagnetic environment
specified below. The customer or the user of the device should assure that it is used in such an
environment.
Immunity test

Conducted RF
IEC 61000-4-6

IEC 60601 test level

3 Vrms
150 kHz ~ 80 MHz
6Vrmsc)in ISM bands
between
0,15 MHz and 80 MHz

Compliance
level

3 Vrms
150 kHz to 80
MHz
6Vrmsc)in ISM
bands between
0,15 MHz and
80 MHz

Electromagnetic environment-guidance
Portable and mobile RF communications
equipment should be used no closer to any
part of the SD3 Series Ultrasonic Pocket
Doppler, including cables, than the
recommended
separation
distance
calculated from the equation applicable to
the frequency of the transmitter.
Recommended separation distance:

d  1.2 P 150 kHz to 80 MHz

d  1.2 P 80 MHz to 800 MHz

d  2.3 P

3 V/m
80 MHz to 2.7 GHz
Radiated RF
IEC 61000-4-3

3 V/m
80 MHz to 2.7
GHz

800 MHz to 2.7 GHz
d=6
/E at RF wireless
communications
equipment
bands
(Portable RF communications equipment
(including peripherals such as antenna
cables and external antennas) should be
used no closer than 30 cm (12 inches) to
any part of the SD3 Series Ultrasonic
Pocket Doppler,
including
cables
specified by the manufacturer).
Where P is the maximum output power
rating of the transmitter in watts (W)
according to the transmitter manufacturer
and d is the recommended separation
distance in metres (m).
Field strengths from fixed RF transmitters,
as determined by an electromagnetic site
survey,a should be less than the
compliance level in each frequency
range.b
Interference may occur in the vicinity of
equipment marked with the following

symbol:
NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies.
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by
absorption and reflection from structures, objects and people.
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a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and
land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted
theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an
electromagnetic site survey should be considered. If the measured field strength in the location in which
the SD3 Series Ultrasonic Pocket Doppler is used exceeds the applicable RF compliance level above, the
SD3 Series Ultrasonic Pocket Doppler should be observed to verify normal operation. If abnormal
performance is observed, additional measures may be necessary, such as reorienting or relocating the SD3
Series Ultrasonic Pocket Doppler.
b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
c The ISM (industrial, scientific and medical) bands between 0,15 MHz and 80 MHz are 6,765 MHz
to6,795 MHz; 13,553 MHz to 13,567 MHz; 26,957 MHz to 27,283 MHz; and 40,66 MHz to 40,70 MHz.
The amateur radio bands between 0,15 MHz and 80 MHz are 1,8 MHz to 2,0 MHz, 3,5 MHz to 4,0 MHz,
5,3 MHz to 5,4 MHz, 7 MHz to 7,3 MHz, 10,1 MHz to 10,15 MHz, 14 MHz to 14,2 MHz, 18,07 MHz to
18,17 MHz,21,0 MHz to 21,4 MHz, 24,89 MHz to 24,99 MHz, 28,0 MHz to 29,7 MHz and 50,0 MHz to
54,0 MHz.

Table-Test specifications for ENCLOSURE PORT IMMUNITY to RF wireless communications
equipment

Test
Frequency
(MHz)

Brand a)
(MHz)

Service a)

Modulation
b)

Maximum
Power(W)

Distance
(m)

IMMUNITY
TEST LEVEL
(V/m)

385

380-390

TETRA 400

Pulse
modulation
b) 18Hz

1.8

0.3

27

2

0.3

28

FM C)
450

430-470

GMRS 460,
FRS 460

710
745
780

704-787

LTE Brand
13, 17

Pulse
modulation
b) 217 Hz

0.2

0.3

9

800-960

GSM
800/900,TE
TRA 800,
iDEN 820,
CDMA 850,
LTE Band 5

Pulse
modulation
b) 18 Hz

2

0.3

28

1700-1990

GSM 1800;
CDMA
1900; GSM
1900;
DECT; LTE
Band 1, 3,
4,25;
UMTS

Pulse
modulation
b) 217 Hz

2

0.3

28

810

870
930

1720

1845
1970

±5 kHz
deviation
1kHz sine
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2450

2400-2570

Bluetooth,
WLAN,802.
11 b/g/n,
RFID 2450,
LTE Brand
7

Pulse
modulation
b) 217 Hz

EMC Information

2

0.3

28

5240
Pulse
WLAN
5500
5100-5800
modulation
0.2
0.3
9
802.11 a/n
b)
217
Hz
5785
Note: If necessary to achieve the IMMUNITY TEST LEVEL, the distance between the transmitting
antenna and the ME EQUIPMENT or ME SYSTEM maybe reduce to 1m. The 1 m test distance is
permitted by IEC 61000-4-3.
a) For some services, only the uplink frequencies are included.
b) The carrier shall be modulated using a 50% duty cycle square wave signal.
c) As an alternative FM modulation, 50% pulse modulation at 18 Hz may be used because while it does
not represent actual modulation, it would be worst case

A3.4 Recommended Separation Distances
Recommended separation distances between portable and mobile RF communications
equipment and the SD3 Series Ultrasonic Pocket Doppler
The SD3 Series Ultrasonic Pocket Doppler is intended for use in an electromagnetic environment in which
radiated RF disturbances are controlled. The customer or the user of the SD3 Series Ultrasonic Pocket Doppler
can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile
RF communications equipment (transmitters) and the SD3 Series Ultrasonic Pocket Doppler as recommended
below, according to the maximum output power of the communications equipment.

Separation distance according to frequency of transmitter (m)
Rated maximum
output power of
transmitter
(W)

150 kHz to 80 MHz

80 MHz to 800 MHz

800 MHz to 2.7 GHz

d  1.2 P

d  1.2 P

d  2.3 P

0.01

0.12

0.12

0.23

0.1

0.38

0.38

0.73

1

1.2

1.2

2.3

10

3.8

3.8

7.3

100

12

12

23
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For transmitters rated at a maximum output power not listed above, the recommended separation distance d in
meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the
maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.
NOTE 1: At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.
NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by
absorption and reflection from structures, objects and people.
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Appendix 4 Ultrasound Intensity and Safety
A4.1 Ultrasound in Medicine
The use of diagnostic ultrasound has proved to be a valuable tool in medical practice. Given its
known benefits for non-invasive investigations and medical diagnosis, including investigation of
the human fetus, the question of clinical safety with regards to ultrasound intensity arises.
There is no easy answer to the question of safety surrounding the use of diagnostic ultrasound
equipment. Application of the ALARA (As Low As Reasonably Achievable) principle serves as a
rule-of-thumb that will help you to get reasonable results with the lowest possible ultrasonic
output.
The American Institute of Ultrasound in Medicine (AIUM) states that given its track record of
over 25 years of use and no confirmed biological effects on patients or instrument operators, the
benefits of the prudent use of diagnostic ultrasound clearly outweigh any risks.

A4.2 Ultrasound Safety and the ALARA Principle
Ultrasound waves dissipate energy in the form of heat and can therefore cause tissue warming.
Although this effect is extremely low with Doppler, it is important to know how to control and
limit patient exposure. Major governing bodies in ultrasound have issued statements to the effect
that there are no known adverse effects from the use of diagnostic ultrasound, however, exposure
levels should always be limited to As Low As Reasonably Achievable (the ALARA principle).

A4.3 Explanation of MI/TI
A4.3.1 MI (Mechanical Index)
Cavitations will be generated when ultrasound wave passes through and contacts tissues,
resulting in instantaneous local overheating. This phenomenon is determined by acoustic pressure,
spectrum, focus, transmission mode, and factors such as states and properties of the tissue and
boundary. This mechanical bioeffect is a threshold phenomenon that occurs when a certain level
of ultrasound output is exceeded. The threshold is related to the type of tissue. Although no
confirmed adverse mechanical effects on patients or mammals caused by exposure at intensities
typical of present diagnostic ultrasound instruments have ever been reported, the threshold for
cavitation is still undetermined. Generally speaking, the higher the acoustic pressure, the greater
the potential for mechanical bioeffects; the lower the acoustic frequency, the greater the potential
for mechanical bioeffects.
The AIUM and NEMA formulate mechanical index (MI) in order to indicate the potential for
mechanical effects. The MI is defined as the ratio of the peak-rarefactional acoustic pressure
(should be calculated by tissue acoustic attenuation coefficient 0.3 dB/cm/MHz) to the acoustic
frequency.
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MI =

Pr, α
fawf × CMI
CMI = 1 (MPa / MHz )

A4.3.2 TI (Thermal Index)
Heating of tissues is caused by absorption of ultrasound when the ultrasound energy is applied.
The temperature rise is determined by the acoustic intensity, exposed area and thermophysical
properties of the tissue.
In order to indicate the potential for temperature rise caused by thermal effects, the AIUM and
NEMA formulate thermal index (TI). It is defined as the ratio of the total acoustic power to the
acoustic power required to raise the tissue temperature by 1ºC (1.8°F).
According to different thermophysical properties of the tissue, TI is divided into three kinds: TIS,
TIB and TIC.
TIS (Soft Tissue Thermal Index): It provides an estimate of potential temperature rise in soft or
similar tissues.
TIB (Bone Thermal Index): It provides an estimate of potential temperature rise when the
ultrasound beam passes through soft tissue and a focal region is in the immediate vicinity of
bone.
TIC (Cranial Bone Thermal Index): It provides an estimate of potential temperature rise in the
cranial bones or superficial bones.

A4.3.3 Measurement Uncertainties
The uncertainties in the measurements were predominantly systematic in origin; the random
uncertainties were negligible in comparison. The overall systematic uncertainties were
determined as follows:
1. Hydrophone Sensitivity: ±23 percent for intensity, ±11.5 percent for pressure. Based on
the hydrophone calibration report by ONDA. The uncertainty was determined within ±1
dB in frequency range 1-15 MHz.
2. Digitizer: ±3 percent for intensity. ±1.5 percent for pressure.
Based on the stated accuracy of the 8-bit resolution of the Agilent DSO6012 Digital
Oscilloscope and the signal-to-noise ratio of the measurement.
3. Temperature: ±1 percent
Based on the temperature variation of the water bath of ±1ºC (1.8°F).
4. Spatial Averaging: ±10 percent for intensity, ±5 percent for pressure.
5. Non-linear Distortion: N/A.
No effects of nonlinear propagation were observed.
Since all the above error sources are independent, they may be added on an RMS basis, giving a
total uncertainty of ± 25.1 percent for all intensity values reported, ± 12.7 percent for all the
pressure values and ±12.6 percent for the Mechanical Index.
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A4.4 Prudent Use Statement
Although no confirmed bioeffects on patients caused by exposure from present diagnostic
ultrasound equipment have ever been reported, the potential exists that such bioeffects may be
identified in the future. Therefore, the ultrasound should be used prudently. High levels of
acoustic output and long exposure time should be avoided while acquiring necessary clinical
information.

A4.5 References for Acoustic Output and Safety
1. “Bioeffects and Safety of Diagnostic Ultrasound” issued by AIUM in 1993
2. “Medical Ultrasound Safety” issued by AIUM in 1994
3. "Acoustic Output Measurement Standard for Diagnostic Ultrasound Equipment,
Revision 3" issued by AIUM/NEMA in 2004
4. "Standard for real-time display of thermal and mechanical acoustic output indices on
diagnostic ultrasound equipment, Revision 2" issued by AIUM/NEMA in 2004
5. "Information for Manufacturers Seeking Marketing Clearance of Diagnostic
Ultrasound Systems and Transducers" issued in 2008.
6. “Medical electrical equipment—Part 2-37: Particular requirements for the basic safety and
essential performance of ultrasonic medical diagnostic and monitoring equipment" issued by
IEC in 2007.
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A4.6 Transducer Acoustic Output Parameters List
Acoustic output reporting table for IEC60601-2-37
(IEC60601-2-37, Edition 2.1, 2015-06, table 201.103)
Transducer Model: SD3 CW2.0
Working Mode: CW mode
Working Frequency:2.0MHz
Index label
MI
TIS
TIB
At
Below
At
Below
surface
surface surface surface
Maximum index value
0.019
0.16
0.40
Index component value
N/A
0.16
N/A
0.40
Acoustic
pr.αat zMI
(MPa) 0.027
Parameters P
(mW)
24.21
24.21
P1x1
(mW)
N/A
N/A
zs
(cm)
2.30
zb
(cm)
2.73
zMI
(cm)
2.80
2.80
zPII.α
(cm)
fawf
(MHz)
2.00
2.00
2.00
Other
prr
(Hz)
N/A
Information srr
(Hz)
N/A
npps
N/A
2
Ipa.α at zPII.α (W/cm ) 0.026
Ispta. α at zPII. α or zSII. α 26.49
(mW/cm2)
Ispta at zPII or zSII 42.63
(mW/cm2)
pr. at zPII
(MPa) 0.037
Operating
control
conditions

Focus(mm)
Depth(mm)
Frequency(MHz)

Fixed
Fixed
2.00
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Acoustic output reporting table for IEC60601-2-37
(IEC60601-2-37, Edition 2.1, 2015-06, table 201.103)
Transducer Model: SD3 CW 3.0
Working Mode: CW mode
Working Frequency:3.0MHz
Index label
MI
TIS
TIB
At
Below
At
Below
surface
surface surface surface
Maximum index value
0.018
0.29
0.46
Index component value
N/A
0.29
N/A
0.46
Acoustic
pr.αat zMI
(MPa) 0.031
Parameters P
(mW)
44.65
44.65
P1x1
(mW)
N/A
N/A
zs
(cm)
3.70
zb
(cm)
3.70
zMI
(cm)
3.75
3.75
zPII.α
(cm)
fawf
(MHz)
3.00
3.00
3.00
Other
prr
(Hz)
N/A
Information srr
(Hz)
N/A
npps
N/A
Ipa.α at zPII.α (W/cm2) 0.025
Ispta. α at zPII. α or zSII. α 25.06
(mW/cm2)
Ispta at zPII or zSII 57.83
(mW/cm2)
pr. at zPII
(MPa) 0.048
Operating
control
conditions

Focus(mm)
Depth(mm)
Frequency(MHz)

Fixed
Fixed
3.00
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Acoustic output reporting table for IEC60601-2-37
(IEC60601-2-37, Edition 2.1, 2015-06, table 201.103)
Transducer Model: SD3 CW4.0
Working Mode: CW mode
Working Frequency:4.0MHz
Index label
MI
TIS
TIB
At
Below
At
Below
surface
surface surface surface
Maximum index value
0.012
0.13
0.15
Index component value
0.13
N/A
N/A
0.15
Acoustic
pr.αat zMI
(MPa) 0.024
Parameters P
(mW)
6.69
6.69
P1x1
(mW)
N/A
N/A
zs
(cm)
N/A
zb
(cm)
2.75
zMI
(cm)
2.75
2.75
zPII.α
(cm)
fawf
(MHz)
4.00
4.00
4.00
Other
prr
(Hz)
N/A
Information srr
(Hz)
N/A
npps
N/A
Ipa.α at zPII.α (W/cm2) 0.017
Ispta. α at zPII. α or zSII. α 16.85
(mW/cm2)
Ispta at zPII or zSII 37.72
(mW/cm2)
pr. at zPII
(MPa) 0.037
Operating
control
conditions

Focus(mm)
Depth(mm)
Frequency(MHz)

Fixed
Fixed
4.00
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Acoustic output reporting table for IEC60601-2-37
(IEC60601-2-37, Edition 2.1, 2015-06, table 201.103)
Transducer Model: SD3 CW5.0
Working Mode: CW mode
Working Frequency:5.0MHz
Index label
MI
TIS
TIB
At
Below
At
Below
surface
surface surface surface
Maximum index value
0.013
0.18
0.24
Index component value
0.18
N/A
N/A
0.24
Acoustic
pr.αat zMI
(MPa) 0.029
Parameters P
(mW)
7.65
7.65
P1x1
(mW)
N/A
N/A
zs
(cm)
N/A
zb
(cm)
1.40
zMI
(cm)
1.40
1.40
zPII.α
(cm)
fawf
(MHz)
5.00
5.00
5.00
Other
prr
(Hz)
N/A
Information srr
(Hz)
N/A
npps
N/A
Ipa.α at zPII.α (W/cm2) 0.030
Ispta. α at zPII. α or zSII. α 29.55
(mW/cm2)
Ispta at zPII or zSII 54.49
(mW/cm2)
pr. at zPII
(MPa) 0.041
Operating
control
conditions

Focus(mm)
Depth(mm)
Frequency(MHz)

Fixed
Fixed
5.00
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Acoustic output reporting table for IEC60601-2-37
(IEC60601-2-37, Edition 2.1, 2015-06, table 201.103)
Transducer Model: SD3 CW8.0
Working Mode: CW mode
Working Frequency:8.0MHz
Index label
MI
TIS
TIB
At
Below
At
Below
surface
surface surface surface
Maximum index value
0.0057 0.098
0.056
Index component value
0.098
N/A
N/A
0.056
Acoustic
pr.αat zMI
(MPa) 0.016
Parameters P
(mW)
2.58
2.58
P1x1
(mW)
N/A
N/A
zs
(cm)
N/A
zb
(cm)
2.15
zMI
(cm)
2.15
2.15
zPII.α
(cm)
fawf
(MHz)
8.00
8.00
8.00
Other
prr
(Hz)
N/A
Information srr
(Hz)
N/A
npps
N/A
Ipa.α at zPII.α (W/cm2) 0.0095
Ispta. α at zPII. α or zSII. α 9.48
(mW/cm2)
Ispta at zPII or zSII 35.89
(mW/cm2)
pr. at zPII
(MPa) 0.033
Operating
control
conditions

Focus(mm)
Depth(mm)
Frequency(MHz)

Fixed
Fixed
8.00
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A4.7 Track1 Acoustic Output Range Summary
TRACK1 SUMMARY
Mode of Operation
Transducer

CW2.0

CW3.0

CW4.0

CW5.0

CW8.0

Global Maximum Output Level

CW mode

Max ISPTA.3 (mW/cm2)
Min ISPTA.3 (mW/cm2)
Max ISPPA.3 (W/cm2)
Min ISPPA.3 (W/cm2)
Max MI
Min MI
Max Isata@transducer face
Min Isata@transducer face
Max ISPTA.3 (mW/cm2)
Min ISPTA.3 (mW/cm2)
Max ISPPA.3 (W/cm2)
Min ISPPA.3 (W/cm2)
Max MI
Min MI
Max Isata@transducer face
Min Isata@transducer face
Max ISPTA.3 (mW/cm2)
Min ISPTA.3 (mW/cm2)
Max ISPPA.3 (W/cm2)
Min ISPPA.3 (W/cm2)
Max MI
Min MI
Max ISPTA.3 (mW/cm2)
Min ISPTA.3 (mW/cm2)
Max ISPPA.3 (W/cm2)
Min ISPPA.3 (W/cm2)
Max MI
Min MI
Max ISPTA.3 (mW/cm2)
Min ISPTA.3 (mW/cm2)
Max ISPPA.3 (W/cm2)
Min ISPPA.3 (W/cm2)
Max MI
Min MI

35.4722
17.5000
0.03547
0.01750
0.0225
0.0162
12.77
5.27
30.8334
19.2886
0.03083
0.01929
0.0210
0.0146
19.91
15.38
18.8302
14.8597
0.01883
0.01486
0.0125
0.0112
32.3369
26.7624
0.03234
0.02676
0.0139
0.0117
10.7050
8.2472
0.01071
0.008247
0.0059
0.0053
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Acoustic Output Reporting Table for Track1
Non-autoscanning Mode
System : SD3
Transducer: CW2.0

Operating Mode:
Working Frequency:

Acoustic Output

MI

Global Maximum Value
Pr.3
(MPa)
W0
(mW)
fc
(MHz)
Zsp
(cm)
Associated
X-6
(cm)
Beam
Acoustic
dimensions
Y
(cm)
-6
Parameter
PD
(usec)
PRF
(Hz)
Az
(cm)
EBD
Ele
(cm)
Operating Control
Conditions

0.01936

CW mode
2.0 MHz
Ispta.3
(mW/cm2)
26.4861

Isppa.3
(W/cm2)

0.02649

0.02738
2.00
2.80

24.21

24.21

2.00
2.80
0.4674
0.4292

2.00
2.80
0.4674
0.4292

2.5
1.25
Fixed

Acoustic Output Reporting Table for Track1
Non-autoscanning Mode
System : SD3
Transducer: CW3.0

Operating Mode:
Working Frequency:

Acoustic Output
Global Maximum Value
Pr.3
(MPa)
W0
(mW)
fc
(MHz)
Zsp
(cm)
Associated
X-6
(cm)
Beam
Acoustic
dimensions
Y
(cm)
-6
Parameter
PD
(usec)
PRF
(Hz)
Az
(cm)
EBD
Ele
(cm)
Operating Control
Conditions

MI
0.01776

CW mode
3.0 MHz
Ispta.3
(mW/cm2)
25.061

Isppa.3
(W/cm2)

0.02506

0.0308
3.00
3.75

44.65

44.65

3.00
3.75
0.4278
0.3619

3.00
3.75
0.4278
0.3619

2.5
1.25
Fixed
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Acoustic Output Reporting Table for Track1
Non-autoscanning Mode
System : SD3
Transducer: CW4.0

Operating Mode:
Working Frequency:

Acoustic Output

MI

Global Maximum Value
Pr.3
(MPa)
W0
(mW)
fc
(MHz)
Zsp
(cm)
Associated
X-6
(cm)
Beam
Acoustic
dimensions
Y
(cm)
-6
Parameter
PD
(usec)
PRF
(Hz)
Az
(cm)
EBD
Ele
(cm)
Operating Control
Conditions

0.01185

CW mode
4.0 MHz
Ispta.3
(mW/cm2)
16.845

Isppa.3
(W/cm2)

0.01685

0.02368
4.00
2.75

6.694

6.694

4.00
2.75
0.4584
0.4769

4.00
2.75
0.4584
0.4769

0.9
0.45
Fixed

Acoustic Output Reporting Table for Track1
Non-autoscanning Mode
System : SD3
Transducer: CW5.0

Operating Mode:
Working Frequency:

Acoustic Output
Global Maximum Value
Pr.3
(MPa)
W0
(mW)
fc
(MHz)
Zsp
(cm)
Associated
X-6
(cm)
Beam
Acoustic
dimensions
Y
(cm)
-6
Parameter
PD
(usec)
PRF
(Hz)
Az
(cm)
EBD
Ele
(cm)
Operating Control
Conditions

MI
0.01281

CW mode
5.0 MHz
Ispta.3
(mW/cm2)
29.5496

Isppa.3
(W/cm2)

0.02955

0.02862
5.00
1.40

7.65

7.65

5.00
1.40
0.2308
0.3587

5.00
1.40
0.2308
0.3587

0.9
0.45
Fixed
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Acoustic Output Reporting Table for Track1
Non-autoscanning Mode
System : SD3
Transducer: CW8.0

Operating Mode:
Working Frequency:

Acoustic Output
Global Maximum Value
Pr.3
(MPa)
W0
(mW)
fc
(MHz)
Zsp
(cm)
Associated
X-6
(cm)
Beam
Acoustic
dimensions
Y
(cm)
-6
Parameter
PD
(usec)
PRF
(Hz)
Az
(cm)
EBD
Ele
(cm)
Operating Control
Conditions

MI
0.005621

CW mode
8.0 MHz
Ispta.3
(mW/cm2)
9.4761

0.009476

2.576

2.576

8.00
2.15
0.3348
0.3245

8.00
2.15
0.3348
0.3245

Isppa.3
(W/cm2)

0.01590
8.00
2.15

0.6
0.3
Fixed
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Appendix 5 Troubleshooting
Phenomenon

Possible Cause

Solution

The speaker does not sound.

The speaker is muted.
Bad connection between the
probe and main unit.
Main board defective.

Turn up the volume.
Make sure that the probe is well
connected to the main unit.
Replace the main board.

Speaker defective.

Replace the speaker.

Probe defective.

Replace the probe.

The volume is too low.

Turn up the volume.
Apply coupling gel on the probe
acoustic surface.
Replace the battery or charge the
rechargeable battery.
Locate the probe at a position
for optimal FHR examining.
Apply coupling gel on the probe
acoustic surface.
Replace the main board.

The speaker sounds weak.

No coupling gel is applied.
The battery is in low energy.

Low sensitivity.

The probe is not placed at
the optimum position.
No coupling gel is applied.

The screen displays nothing
and the speaker does not
sound after the main unit is
switched on.
The speaker sounds but the
screen displays nothing or
displays wrong characters
after the main unit is
switched on.

Main board defective.
The battery is in low energy.

Replace the battery or charge the
rechargeable battery.

Main board defective.

Replace the main board.

Speaker defective.

Make sure that the environment
in which the device is operated
is not subject to any source of
strong electromagnetic
emissions.
Replace the speaker.

Probe defective.

Replace the probe.

Main board defective.
The probe has not been
taken out from the probe
holder when the main unit is
switched on.

Replace the main board.

The device is subject to
strong electromagnetic
emissions.

Loud noise.

The battery is in low energy.

The screen displays nothing

Too much coupling gel on
the probe acoustic surface.
Power adapter defective.
- 53 -
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probe holder before switching
on the main unit.
Replace the battery or charge the
rechargeable battery.
Wipe the residual coupling gel
off the probe after each use.
Replace the power adapter.
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or displays charge error
Battery defective.
when the Doppler (SD3
PLUS or SD3 PRO) is being Main board defective.
charged.
Charge stand defective.
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Replace the battery.
Replace the main board.
Replace the charge stand.

SD3 Series Ultrasonic Pocket Doppler User Manual

Overall Sensitivity

Appendix 6 Overall Sensitivity
Diameter of
Target
Reflector(mm)

Distance
(d)(mm)

A(dB)

50

32.5

75

36.0

2.38@2 MHz
100

200

38.5

45.5

Two-way Attenuation
B=∑Ba+Bw
∑B (T: ultrasonic attenuation
Bw
phantom No. Ba:dB)
(dB)
T
Ba

6#

T

6#

6#

6#

6#

5#

6#

5#

6#

66.1
4#

6#

Ba

1#

1#
-

59.9

Doppler Frequency (Hz)

66.1

32.5

75

36.0

100

38.5

200

45.5

2.38@3 MHz

6#

6#

87.3

-

T

6#

6#

-

-

Ba

Ba

104.77

66.1

174.8

85.4

6.22

108.32

0

66.1

174.2

87.5

5.98

110.58

0

59.9

300.2

142.3

6.48

110.88

0
0

87.3
6#

6#

Ba
T

6.17

Velocity of Target
(cm/s)

T
Ba

T

100.4

204.2

0

299

50

Doppler Frequency (Hz)

0

dB

Vn(r.m.s)
mV

66.1

Ba
T

1#

66.1

Ba
T

5#

B
(dB)

 V r.m.s. 

C  20 log 10  s
 Vn r.m.s. 

Overall Sensitivity
(S=A(d)+B+C)
dB

VS(r.m.s)
mV

-

-

0

87.3
6#

6#

-

-

0

87.3

87.3
87.3

87.3

94.5

49.7

5.58

125.38

90.3

49.8

5.17

128.47

105.2

51.5

6.04

131.84

85.5

52.5

4.24

136.00

87.3

Velocity of Target
(cm/s)

410
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12.5

12.5

